
1 
 

 

 

  

WORKING MANUAL 



2 
 

Contents 
Installation ...................................................................................................... 4 

System Requirements ................................................................................. 4 

Program USB Protection Key (USB dongle) ................................................ 4 

Program Installation from DVD .................................................................... 5 

Program Registration .................................................................................. 5 

License Deployment ................................................................................... 5 

Installing Plotters ........................................................................................ 7 

Data Update ................................................................................................... 8 

Open a Pattern ............................................................................................... 9 

DB Access Tool Filters ................................................................................. 10 

Cut the Pattern ............................................................................................. 16 

The Program Interface .................................................................................. 22 

Main Window ............................................................................................ 22 

The Control Center ................................................................................... 23 

The Navigation Window ............................................................................ 24 

The Main Menus ....................................................................................... 26 

File ........................................................................................................ 26 

Edit ........................................................................................................ 27 

View ...................................................................................................... 30 

Transform .............................................................................................. 32 

Text ....................................................................................................... 32 

Bitmap ................................................................................................... 32 

Arrange ................................................................................................. 33 

Window ................................................................................................. 35 

The Tool Bars ........................................................................................... 37 

Standard Bar ......................................................................................... 37 

Tools Bar ............................................................................................... 38 

Working with Text ......................................................................................... 40 

Selecting the Attributes of the Text ............................................................ 40 

Alignment and Line Spacing...................................................................... 41 



3 
 

Distorting Letters ....................................................................................... 42 

Spacing Between Letters and Words ........................................................ 43 

Graphical Adjustment ................................................................................ 44 

Saving the Text Set-Up ............................................................................. 44 

Entering Symbols ...................................................................................... 45 

Vertical Text .............................................................................................. 45 

Adapting Text to Curve ............................................................................. 46 

Position with Regard to the Curve ............................................................. 47 

Alignment .................................................................................................. 47 

Direction of the Characters ....................................................................... 47 

Orientation ................................................................................................ 48 

Reversing the Direction ............................................................................. 48 

Working with Shapes .................................................................................... 49 

 Rectangles Button .............................................................................. 49 

 Ellipses Button ................................................................................... 50 

 Polygons Button ................................................................................. 51 

 Stars Button ....................................................................................... 51 

 Digitize / Bitmap Tracing Button ......................................................... 53 

 Point Digitization Button ..................................................................... 53 

 Free Hand Drawing Button ................................................................. 53 

 Outlines Button .................................................................................. 54 

Distortions ................................................................................................. 56 

Perspectives ............................................................................................. 57 

 

  



4 
 

Installation  

System Requirements 

CPU 1Ghz x86 compatible CPU 

RAM  Minimum 4Gb for Windows XP SP3, 
4GB or more for Windows Vista, 
Windows 7/8/8.1/10 
 
4Gb or more is recommended RAM 
size 

Disk Space 1.5Gb + size of the RAM x 2 of the 
free disk space is required  

Display Minimum 1024x768px resolution  
 
1280x1024px or higher resolution is 
recommended   

Operating system Windows 7/8/8.1/10 
 
Both x32 and x64 versions of 
operating listed above are supported 

Video card No special requirements  

 

Program USB Protection Key (USB dongle) 

 

The program comes with a USB protection key (USB dongle), which limits the 

use of the PC to which it is connected. With the PC turned off, place the USB 

protection in a USB port. 
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Program Installation from DVD 

To install the program, insert the DVD provided into your DVD drive and the 

installation program will start up automatically. Once started, please follow the 

instructions shown on the screen or if a DVD is not supplied to load the software 

call your distributor for further assistance to set up the software. 

If Autorun feature is disabled, then browse the root of the DVD and launch 

“start.bat”. 

Program Registration 

You need the Key Number (the license number) and your license password to 

perform the registration. You can find the Key Number on your USB dongle.  

Launch the Client tool, in the main menu open the “Registration”, the 

Registration form will appear. Enter your Key Number and password and then 

click “Register”. The Client tool will send the request to the server and then 

receive license information. Please, check, that information is correct, otherwise 

contact the tech support. 

 If you do not have a password, then you can request it by clicking 
the “I do not have Password or Activation key” link located under 
the “Register” button. The system will send your password to the 
e-mail address specified for your account.  

 

 Make sure you have the registration sheet stub on hand, as it 
contains your program registration number. This number will have 
to be quoted to your Distributor whenever technical support service 
is needed, or when upgrades are required 

 

License Deployment  

Normally the license deployment runs automatically right after successful 

Registration.  

If Program cannot find the license, you need to deploy it manually. To do this, 

open the Client tool, go to the tab “Emergency” and click the link “Deploy …” 
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Make sure that all items have green checks, otherwise contact tech support.  
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Installing Plotters 

To start using the cutting option of the FVD Film Designs 4.0 (the program), you 

need to install a plotter (plotters). When you install the program for the first time, 

or when you want to add a new plotter or change the existing one, you need to 

install it into the program.  

When running the program for the first time, during the startup process the 

Device configuration window will appear.  

To install a plotter, click the Add button (unless you have acquired the 

program net support) and you will be able to access the window containing 

the lists of available plotters.  

 

Find your plotter and press Install. If your plotter does not appear in the list, 

consult your dealer to check for possible replacements.  
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You need to configure each plotter you plan to use, the way it will be connected 

to the computer (communications port) and whether you want to send your work 

straight to the device or use the job manager.  

After you selected the plotter and clicked on the Install button, you will be taken 

back to the Device configuration window, where you need to select the 

Сonnection type.   

The Advanced button allows you to configure the specific advanced options for 

each plotter (see corresponding section). 

Data Update 
At the bottom left corner of the DB access tool window you can find the Last 

sync date.  

 

When it starts to blink, it is a signal for you to check for the program updates. 

You should click on the blinking CHECK FOR UPDATES button at the top right 

corner of the DB access window. The following pop up window will appear: 

 

The program will install all latest updates and put the latest Last sync: date.  
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Open a Pattern 
To open a pattern, click the Open pattern from the database button on the 

Tool Bar. 

 

The DB access tool window will appear.  

 

Select the pattern you plan to cut and click the Open normally button. The 

following window will appear.  

 

Please note that the height of the Working Area corresponds to the width of the 

bobbin, while the base of the working area corresponds to the length of the 

bobbin. Please, make sure that any design, which can be seen horizontally in 

the window, appears alongside the bobbin. If this is not the case, either the 

plotter or the program is configured incorrectly. 
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Click the Open mirrored button if you want to open a pattern in a mirrored 

format.  

DB Access Tool Filters 
The DB access tool window contains two filter bookmarks: Basic filter and 

Extended filter. 

Under Basic filter bookmark you can find two different representations of the 

pattern views: the tree view and the drop down view .  

The tree view sorts the patterns in the 

following order:  

Make -> Model -> Trim -> Year. 

For example: 

Jeep -> CHEROKEE -> 4 DR SUV -> 

2001.  

You need to find and select the patterns 

you need by expanding each category.  

 

 

 

 

                      

The drop-down view proposes different order of pattern type categories: 

Year -> Make -> Model ->Trim 

For example:  

2001 -> Jeep -> WRANGLER -> RUBICON 
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Under Basic filter bookmark you 

can filter patterns by the VIN 10th 

character (year) or by 

pattern type . Please note, 

that letters in the pattern type filter 

(in our example SLG) denote the 

pattern types that are selected at 

the moment. They can differ from 

your preferences.  

To filter by the VIN 10th character (year), click the button. The 

following pop-up window will appear: 

 

Type the last number of the year you want to select, and the desired year will 

show to the right of the equal sign.  

 

Click on the field to the right of the equal sign that displays the year you want 

to select (in our example, 2007) and the filter will be set to that year. The 

patterns tree will display only patterns for the year selected and the filter 

button will be changed to inform you about the filter applied . In 

case, you want to cancel the filter selection, click on the red cross on the filter 

button. 
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Under the menu Info -> VIN 10th char, you can find the VIN 10th position 

decoding table.  

 

To filter by pattern type, click the funnel-button (pattern type filter). The 

following pop up window will appear: 
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You can select from the following pattern types1: 

[S] Short – patterns that fit the car element precisely from edge to edge.   

[L] Long – patterns that have a small margin around the car element edges.   

[B] Bumper Urethane – patterns for bumper protection. 

[H] HFM Urethane – patterns for hood, fender, and mirror protection. 

[T] Lights Urethane – patterns for lights protection.  

[U] Other Urethane – all other types of patterns (like signs, for example).  

Check the pattern types you want to select, or click the Select all types 

button at the top left corner to select all available pattern types.  

Click Apply button at the bottom right corner to apply the selection.  

Please, note that letters that appear on the filter by pattern type button on the 

DB access tool main window correspond to the pattern types selected. For 

example, if you select [B] Bumper Urethane and [H] HFM Urethane, the button 

will look like this  (the pattern type [S] Short, cannot be removed from 

selection). 

You can also disable groups of patterns by clicking on the DISABLE button at 

the top of the pattern type group column. The button will change to the 

ENABLE button. 

                                                                 
1 Please, note that different types of users have different sets of pattern types 
available to them. Current manual describes the Demo Subscription.  
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To enable the pattern type group, click on the ENABLE button or Select all 

groups button at the top left corner of the Pattern Type window.  

The Reset filter drop down box has two options: Set default and Reset 

all.  

If you select the Set default option, the following confirmation window will 

appear.  

 

When you click Yes button, all tree view and drop down settings will be set to 

default.  

If you select Reset all option, the following confirmation window will appear.  

 

When you click the Yes button, all forms will be reloaded and all filters will be 

reset.  

Extended filter allows you to tune Basic filter according to your needs. You 

can define the Year range and Makes of patterns that will be shown in the 

Basic filter, as well as limit the patterns to the ones produced by certain 

Authors only.   

The Year range bookmark allows you to define the time span of the pattern 

list displayed in the Basic filter.  
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Check the Enable filter by year 

check box, to activate the year drop 

down box. After you select the year, 

you can pick to display all patterns 

older or newer than this year. So, if 

you selected all the patterns newer 

than 2013, the Basic filter will contain 

only patterns newer than the year 

2013.  

Click the Reset filter button to cancel 

manual filter tuning. 

The Makes bookmark allows you to 

define Makes displayed in the Basic 

filter.  

Check the Enable filter by make 

check box, to activate the Make list. All available Makes will be selected by 

default. If you want to deselect all Makes, click the Select none option. In our 

example, we selected only one make – Jeep. In this case, the Basic filter will 

display only patterns for Jeep.  
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The Authors bookmark allows you to limit the list of patterns displayed in the 

Basic filter only to selected Authors.  

Check the Enable filter by author check box, to activate the Authors list. All 

available Authors will be selected by default. If you want to deselect all 

Authors, click the Select none option. Then select only those authors whose 

patterns you want to see in the basic filter. 

Cut the Pattern 
To cut the pattern: 

 Press the “Ctrl+F5”, or 

 In the File menu, select the Cut! Option, or 

 
 In the Control Center form, click the Cut button. 

 

 

On the pop-up form, click the Cut button to proceed with cutting.  
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As you can see on Pic.9, the Cut window contains four bookmarks: 

Accounting, General, Paneling, Options.  

Accounting: Here you can specify the Username and Password for the 

Accounting program. In this case, the cut info will be automatically transmitted 

into the Accounting program. 

You can also specify the Order Type – Purchase, Repair, Waste Process, or 

Waste Vendor.  

General: Here you can specify the Cut Mode, make the program pause 

before cutting (Pause before Starting to Cut check box) and keep the job 

open after the cut is done (Keep Job once Finished check box).  
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Paneling: Here you can choose to Cut All Pages of the design or Only 

Selected Pages. If the design fits into one page, the Only Selected Pages 

option will be disabled.  

You can also select the program behavior after the program is done cutting 

the selected design. You can set the program to Get Back to Origin or 

Continue with the Following design. The Offset can also be set manually. 

You can choose to Pause between Columns or Pause between Rows.  

 

Options: Here you can choose the level of Curve Cutting Resolution (from 

highest to lowest), as well as cutting Speed and Force. You can also select 

the cut order from Origin to End, from End to Origin, or no order at all. You 

can choose to Cut Inner Paths First and Unidirectional Cutting.  



19 
 

 

The Advanced… button will take you to the following window with four 

bookmarks Axes, Plotter Control, Enhancements, Resolution.  

 

Axes: Here you can change the HPGL Axes Disposition by clicking on the 

Expand X-axis (rotate-90) checkbox. You need to change this parameter if 

screen X-axis does not match plotter roll advancing direction. You have an 

ability to save this setting as default (Save as Default checkbox).  

Plotter Control: You can control Cutting Speed, Tool Force, and Tool 

Acceleration from within the program. Uncheck these options if you prefer to 

set the plotter manually. You have an ability to save this setting as default 

(Save as Default checkbox). 



20 
 

 

Enhancements: In you are using an old plotter; you can enhance the cutting 

quality by selecting the following options within the program. Check the Close 

Figures checkbox, if the plotter does not properly close figures. Check the 

Turn Blade checkbox to improve the corner cutting quality. You can also 

select the Use Arcs for Curves option. You have an ability to save this 

setting as default (Save as Default checkbox). 

 

Resolution: Here you can adjust the conversion factors between design units 

(mm) and plotter units (steps) by X and Y-axis. You can also set them as 

default values for the plotter (Set as default values for this plotter check 

box). You have an ability to save this setting as default (Save as Default 

checkbox). 
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The Program Interface 

Main Window 

When you launch the program, the program greets you with the introductory 

window containing the program version and its registration number. Wait a few 

seconds and the program working area will appear. 

 

It contains the following elements: 

 The title bar with the control menu on the left and the maximize / 

minimize buttons on the right. 

 The window border, which allows changes to window dimensions 

when not totally extended.  

 The menu bar from which you can choose different actions. 

 The buttons bar with the most frequently used options. 

 The tools bar where the creation tools and the zoom are located. 

 The program working area, where the designs are located. Above 

and to the left of this window there are instructions, which help you to 

find out the sizes that you are working in. These instructions can be 

disabled, if you wish. 

 The scroll bars, located in the bottom right-hand corner, below the 

working area, allow you to see the part of the design hidden in the 

top right-hand corner, above the working area. 

 The lower fly out menu. 

 The status bar, where the program shows you data on the design that 

you are working with. 
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 The Control Center, from which you can carry out all the necessary 

transformations, as well as configure the plotter and establish the 

parameters for the cut. 

Please note that the height of the Working Area corresponds to the width 

of the bobbin, while the base of the working area corresponds to the length 

of the bobbin. Please, make sure that any design, which can be seen 

horizontally in the window, appears alongside the bobbin. If this is not the 

case, either the plotter or the program is configured incorrectly. 

 

The Control Center 

The Control Center is a fly out dialog box, which is 

used to control most of the program functions along 

with its configurations. 

It can be placed in any part of the working area, or 

set as a part of the main window, by moving it to the 

right or left of the main program window. In this case, 

you will see that the Control Center is integrated into 

the main program window, and it changes the 

working area so that the window becomes visible 

and not hidden below the Control Center window. 

The operation tree appears at the top of the Control 

Center. These functions appear and disappear, 

depending on the objects selected and the possible 

actions that can be performed at every given 

moment. 

There are functions that appear within the main 

section and are shown as branches of the main 

section. 

If a main section contains hidden branches, a “+” 

sign appears in front of it. To display all the hidden 

branches, click the “+” sign, which will then convert 

to a “-“ sign. To hide the branches click the “-“ sign. 
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 You will see the Undo button in many of the Control Center windows. This 

has the same function as the Undo button in the Transformations Bar or the 

Undo action of the Menus Bar. It is used to cancel the carried out action. 

 Many of the actions that are carried out from the Control Center 

require the use of the Apply button. To apply changes from manual value 

modification you need to click the Apply button as well. 

 The Help button appears in all the program windows. By clicking this 

button, you can access the available context help. 

The Navigation Window 

The Navigation window is a utility for managing the 

viewing of the program working area. This includes 

all the zoom functions, and a window where the 

whole design and the area displayed in the current 

working area can be seen.  

To access the Navigation window you can select the 

Zoom Navigator button next to the Control Center. 

In the Navigation window, you can see a rectangle 

or frame, with a point in the center that covers all or 

part of the design displayed within it. This rectangle, 

or frame, shows the view being displayed in the 

program working area. 

According to the size of the design, a dotted line may be seen showing the lower 

horizontal limit (position 0) of the working area. Remember that you must not 

situate objects below this line since they would not be cut. 
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By clicking the central point of the panel, the panel can be moved to the area 

you want. By doing this, the part of the design that is within the panel will be 

displayed in the working area. 

If you wish to create a new frame in any area of the design, click the Navigation 

window and drag the mouse pointer to form the frame. This will be the new view 

of the working area. The new frame will adapt to the real area displayed. Thus, 

for example, if you make a very long frame, this will change and become 

squarer, keeping to the proportions of the working area. 

 

To modify the size of the frame, increase or reduce the zoom level of the 

working area, click on one of the corners of the panel. When the cursor is in 

these corners, its shape changes. Without releasing the mouse button, move 

the cursor to enlarge or reduce the rectangle. 

                          

There are two buttons available just to the right of the Navigation window to 

increase or reduce the size of the frame; in other words decrease or increase 

the zoom level of the working area. 
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The Main Menus 

File 

New  
This action menu allows you to clean the screen of all previous drawings and 

to begin a new one. If previous drawings had not been saved, a pop-up 

message will give you the opportunity to save them.  

Open 
This action menu allows you to load a previously saved file. The standard 

Windows Open File dialog box unfolds. Select the file with the cursor and click 

the Yes button, or just double-click on the needed file. You will see a sample on 

the preview window. If it does not appear, it may be that the file is from an older 

version, in which case, load this file and save it again. Next time the preview 

will appear.  

If you want to change the default directory, double-click on the directory you 

want to set as a new default (yellow file symbol). If the directory you are looking 

for does not appear on the list, click the first file twice (corresponding to the root 

directory of the current disc unit) and repeat the search. 

Close  
This action menu allows you to close the active window, reminding you that you 

must save the changes, if you have not previously saved them.  

Save and Save As  
Standard file save menu options. 

Import  
This action menu allows you to import (open) an already existing in the 

database file.  

Export 
This option allows the file to be saved with different format which is the same 

as or different to the one the program generates.  

Setup Plotters  
This action menu allows you to configure the program in accordance with your 

plotter specifications and to control some of plotter parameters. For further 

details, please, see the Plotter Options section.  

Usually, the plotter configuration has to be carried out only when you install the 

software for the first time, although you will have to gain access to this window 

if you are using materials of different sizes, since the software has to know the 

width of the bobbin you are using.   
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Cut! Preview 
This action menu allows you to view how a pattern will be located on the film 

roll before you actually cut it. This feature promotes the efficient film use and 

lets you save, minimizing waste.  

Cut! 
This action menu allows you to cut the active pattern. In the pop-up Cut window, 

you can specify and configure plotters and enter information for the Accounting 

application.  

Quick Cut! 
This action menu allows you to quickly cut the pattern without entering any 

additional information.  

Cut Report 
This action menu allows you to view all cuts performed within the selected time 

period. 

Exit  
This is the last option in this section and it is used to quit the program. When 

you select it, it will close down the program without leaving the Windows 

environment.  

Edit 

Undo, Multiple undo  
With this option, any modification you have made will always go back one step. 

The menu will be deactivated when you cannot undo. The number of steps that 

can be undone is shown in the preference screen. Remember that a very high 

value for undoing requires a lot of memory.  

The multiple undo allows you to choose from which action you wish to undo. 

This is the same as clicking the undo button several times until you have the 

design the way you want it, but it is much more convenient, and as the list shows 

all the actions done, it is much easier to return to a previous state.  

Cut, Copy, Paste  
By clicking Cut, the selected object is copied to the clipboard, and the design is 

deleted. If you click Copy, the selected object is copied to the clipboard without 

the design disappearing. By clicking Paste, the objects in the clipboard, which 

are compatible with the program, will be added to the design.  

Delete  
This option allows you to delete selected objects. If you choose this option by 

mistake, remember that you can undo the action and restore the deleted.  
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Duplicate  
This option allows you to duplicate the selected objects. In other words, an 

identical copy of selected objects will be made. The objects’ position in relation 

to the original is controlled by the Preferences dialog (Edit->Preferences).  

Cancel  
While the program is performing any process like effect calculations or cutting, 

you can select this option to cancel the process.  

Select All  
Use this option to select all of the objects in the design. This can also be done 

by pressing F6.  

Unselect All  
With this option all the objects which have been selected will be deselected.  

Invert Selection  
This option allows you to deselect the objects currently selected, and select all 

the other objects (not already selected).  

Preferences - View 

 

When you activate the Show Page Limits, a broken line appears on the screen, 

showing the limits of the selected page (usable limits of the material loaded into 

the plotter). You can also select the color of the page limits line in the drop down 

box displayed next to the Show Page Limits option.  

Show Grid - this refers to a grid pattern which appears as a background in the 

working area and is used as reference for situating different objects in the 

working area. Click the drop down color box and you can modify the color of 

these lines. It is possible to set the measurements of this box by controlling its 

width and height. To do this, enter in Horizontal Grid and Vertical Grid values.  
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The option Show Bitmap Colors in Wireframe Mode allows you to visualize 

the color images and not grey ones while you are working in the lines mode. 

Zoom Undo Levels: This adjustment controls the number of times you can go 

back in the zoom tool. Remember that the undo levels use up memory.  

Preferences - Edition  

 

Offset Duplicates - allows you to set the size in which the objects duplicated 

with respect to the original will be offset. It is possible to enter a value to control 

the horizontal and vertical movements separately.  

Undo Levels - this can be used to adjust the number of times that you can undo 

finished actions. Remember that increasing this amount may consume a lot of 

memory.  

Snap to Guidelines - you can establish whether you wish the guidelines to 

have a “magnet”. In other words, when an object comes close to a guide, it 

moves until it touches the guide. Activating this option you can also fix the 

Margin in pixels (screen resolution points) from which the object will be 

attracted.  

Preferences – Keyboard 
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Keyboard Movement - in this section, you can set the movement the selected 

objects will make when they are moved using the cursor keys. The movement 

can be controlled by pressing the cursor key together with the control and shift 

key. By combining these three keys an object can be moved accurately or 

quickly.  

Preferences – Saving 

 

In this window, you can determine whether you want a Backup copy to be 

generated when the job is saved. In other words, if a job that already existed is 

being altered, the previous one will be saved with another extension, and the 

file will be updated. You can also activate the Autosave Recovering 

Information that is generated in case there is any problems, and the whole job 

will not be lost if we have not been able to save the information.  

If this option is activated, you can set the time interval that will elapse from the 

first time the safety copy was made. The operation of making the safety copy is 

barely noticed, since it is done quickly, making use of the operating system's 

multi-tasking.  

View  

This allows you to control the shape and size of the design on the screen. There 

are seven sub-menus:  

Workspace  
This menu allows you to decide which utilities will appear in the program 

working area.  

There are sub-menus offering the following options:  

 Standard - refers to the buttons bar, which contains the buttons for 

actions such as open, save, etc.  

 Tools - refers to the buttons bar, which contains the buttons for 

selecting, node editing, creating objects, special effects and cuts.  
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 Zoom - this refers to the buttons bar, which contains the buttons for 

zoom actions.  

 Rulers - these are the rulers, which appear above and to the left of 

the working area.  

 Status Bar - this is the information bar which shows the properties of 

the selected objects, the position of the cursor, etc.  

 Control Center - this refers to the window from which all the effects 

and the set-up of the plotter are controlled.  

 Properties - this is the bar, which contains information about the 

selected objects and other options.  

 Actions - this refers to the button bar, which contains the buttons for 

transformations.  

 View Navigator - this window lets you control the view of the working 

area and make zooms.  

 Color Palette - this refers to the horizontal bar, which is found above 

or below the working area and which consists of small squares 

containing the colors available that can be assigned to the objects.  

 Visible colors - show or hide the visible color window.  

 File Browser - show or hide the file administrator to view all the 

designs we have.  

 Customize - this allows customizing all the menus, bars and short 

cuts of the program interface.  

Wireframe  
In this mode we see the designs in the working area represented by the lines 

of their outlines (which is what will actually be cut), along with all the lines of the 

same color. This mode is sometimes handy for representing objects which are 

white, and which would be almost invisible in another mode.  

Color Wireframe  
In this mode the lines of the pattern outlines can be seen, but each line has the 

color of the object it represents, so that all the colors of the design can be 

distinguished.  

Preview Mode  
In this mode the objects are displayed filled in with color, showing how the 

finished job will look.  

Alternate Mode  
In this mode, we can go from the lines in color mode to the preview mode. You 

can use the F9 key to shortcut the process. In other words, by pressing this key, 

the objects go from being seen with fill-ins to being visible in the line mode.  

Zoom  
There are 8 related zoom submenus that allow you perform all kinds of zoom 

variations with the pattern.  
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Full Screen  
In this mode the program working area appears as big as possible with the 

hidden caption bar and menu bar.  

Redraw  
This mode allows you to redraw the whole screen in case any object(s) have 

been badly drawn for whatever reason.  

Transform  

Convert to Curves  
This function allows you to edit the nodes of any object. Please, note that all 

properties of the object will be lost, and could not be brought to the original 

version.  

Text  

Weld Characters  
This joins the characters of a text. In the case of letter types whose letters 

overlap when the text is entered, this function will join these characters.  

Normal Text  
To place the text horizontally.  

Vertical Text  
To place the text in a vertical position.  

Fit Text to Path  
To place the text on a path.  

Convert to Curves  
This function lets us edit the nodes of a text, but the properties of the text are 

lost, and we cannot edit them later. There are four ways of converting curves: 

the whole text, by line, by word and by character. For example, in the last case, 

an object is generated for each letter.  

Separate  
This separates a paragraph of text into lines or words so that we can manipulate 

them individually.  

Bitmap  

Scan  
This allows you to directly activate any TWAIN-compliant device, usually a 

scanner.  
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Configure Scanner  
A dialog box will appear where you will be able to select the TWAIN device you 

wish to use in order to obtain the image (if you have more than one TWAIN 

device installed).  

Import Bitmap  
This functions allows you to import any image from a storage unit, disc, hard 

disc, CD-ROM, etc.  

Export Bitmap  
This function allows you to save a bitmap object to a file in any of the support 

bitmap formats.  

Automatic Trace  
With the vector tool, it is possible to convert an image from bitmap into lines 

and curves.  

Photocut  
With this function, it is possible to reproduce a photographic image in strips, 

which reproduce the image’s gray levels  

Arrange  

Combine  
This option converts several objects into one object, while keeping the attributes 

of the first object. Once combined, these objects will become one and will be 

selected and manipulated as one object.  

Break Apart 
This option breaks a complex object into several simple objects. That is to say, 

as many objects will be created as there are curves or paths in the initial object.  

Group  
This option groups all selected objects into one object – group - which can then 

be selected and manipulated as a single object. Several groups can be grouped 

into a larger group, and groups of images, texts, curves and other groups can 

also be grouped into a single group.  

Ungroup 
This option allows you to ungroup the objects that had been grouped using the 

group option. If there are different levels of groups, this option will ungroup the 

upper level group.  

Ungroup all 
This option allows you to separate grouped objects and, if the group was 

composed of other grouped objects, it will separate the objects until they are all 

ungrouped.  
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Order  
This is divided into 5 sub-menus. The results of these functions affect the order 

of the objects, and the result can only be seen when the View->Preview Mode 

menu is activated.  

 To Forward - this option places the selected object over the other 

objects.  

 To Back - this option places the selected object under the other 

objects of the design.  

 Forward One - this option places the selected object one step forward 

in relation to the other objects.  

 Back One - this option places the selected object one step back in 

relation to the other objects.  

 Invert Order - the Invert Order option reverses the order of the 

selected objects in relation to the current order.  

Auto Nest  
The program has a special function to order the objects within the working area 

so they occupy the minimum possible space which allows you to save the 

material.  

 

Nest Only the Selected Objects - it will arrange only the selected objects 

without moving those which are not.  

Ignore NON-Selected: When arranging the selected objects the space 

occupied by non-selected objects will not be taken into account. As a result, 

some objects might be placed on others. This feature might be useful, for 

instance, if there is a large square around the objects but we want to arrange 

only the objects inside the square, not the square itself.  

Object Spacing - minimal separation that must exist between all objects.  

Enable Object Rotation - when activated, it allows the program to search for 

the most efficient object placement, accounting for object rotation, if needed.   
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Timeout – if you have many objects, the time for the calculation of the best 

position could be very long. By limiting the calculation time to a certain value, 

you can guarantee a fast enough result.  

Window 

New Window  
Using this option, a new working window can be created with a copy of the 

same active document - in other words, a new document with the same design, 

without the need to close any existing open designs.  

If you wish to create a new blank document, you must choose the menu File-

>New. Since the program works in a multi-document interface (MDI), it is 

possible to work with several different designs at the same time, without having 

to close the others, and with the possibility of copying and pasting objects 

between these documents. You can also work on the same design in two 

different windows. For example, one in line editing mode, and one in preview 

mode. In this way we can be editing nodes, for example, and observing the 

result in the other window.  

Cascade  
Arranging in cascade places the different open design windows in such a way 

that they remain at the same size and one above the other, but offset slightly 

so that the maximum number of windows can be seen.  

Tile  
Organizing in tiles places the windows of open documents side by side in the 

case of tile horizontally, or one on top of the other in the case of tile vertically, 

sharing the usable space in equal parts amongst all the windows. In the case 

of having a lot of windows open, both horizontal and vertical tiling act in the 

same way. In this case, they allot the available space for windows to display as 

many open windows as possible.  
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In this case, the program attempts to reserve the maximum possible space for 

the active window, placing it in the top right-hand corner of the area for windows. 

Arrange Icons  
If any, or all, of the windows are minimized, this option situates the icon of each 

window below and to the left, side by side in an organized manner.  

Active Window  
The second part of the window menu displays a list of all open windows with 

the corresponding document name.  

One of these windows is checked, and 

corresponds to the active window. You 

can make any of the others active by 

clicking the one desired, or by clicking the 

surface of the window you want. 
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The Tool Bars 

Standard Bar 

 

 New Design button  
This corresponds to the File->New menu, and is used to begin a new design, 

discarding the one which was on the screen. 

 Open File button 
 This corresponds to the File->Open menu, and is used to recover a previously 

saved design in order to continue working on it or tracing. 

 Open Import button  
This corresponds to the File->Import menu, and is used to import a saved 

design in order to continue work on it for tracing. 

 Open pattern from a database button and  Import pattern from a 

database button 
This corresponds to the File->Open Database menu, and is used to open a 

pattern from the program database in order to cut or modify it. 

 Save button 
This corresponds to the File->Save menu and is used to save the active file on 

the screen. To be safe, we recommend that you use it regularly. 

 Delete button  
This erases the objects selected at the time. If you choose this option by 

mistake, remember that you can undo the action and restore the deleted. 

 Cut button,  Copy button,  Past button 
These are used to transfer objects by means of the clipboard. By clicking Cut, 

the selected object will be copied onto the clipboard and the design will be 

deleted. If Copy is clicked, the selected object is copied onto the clipboard 

without the design disappearing. By clicking Paste, the objects compatible with 

the program which are in the clipboard will be added to the design. 

 Undo button  
It is used to go back after carrying out a transformation. 
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 Line button  
With this mode we see the designs in the working area represented by the lines 

of their outlines (which is what will actually be cut), along with all the lines of the 

same color.  

 Color Line button  
With this mode the lines of the outlines can be seen, but each line has the color 

of the object it represents, so that all the colors of the design can be 

distinguished. 

 Solids button  
In this mode the objects are displayed filled in with color, showing how the 

finished job will look.  

 Full Screen Mode button  
Allows you to view the design window as big as possible, hiding the caption bar 

and menu bar. 

 Print button  
This is used to print the design 

 About button  
This shows the program information, the serial number and the setup data. 

Tools Bar 

 

 Selection Button  
This is used to choose the elements of the design that you wish to work with in 

some way. Please, remember that if an element has not been selected, it is not 

possible to make any changes to it. 

 Measure Button 
This tool is used to take the measurements of any area of the design. 

 Resize Button  
This tool creates a Blue Box around the shape to be resized and inside this 

Blue Box is a dashed Cross Hair.  The Cross Hair can be adjusted up or down, 

left or right, and the pattern can be resized from those points to add or take 

away for the length or width without changing the shape of the other areas of 

the pattern. 
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 Node edit Button 
This is used to correct the shapes or outlines of the design. 

 Resize Button  
This tool creates a Blue Box around the shape to be resized and inside this 

Blue Box is a dashed Cross Hair.  The Cross Hair can be adjusted up or down, 

left or right, and the pattern can be resized from those points to add or take 

away for the length or width without changing the shape of the other areas of 

the pattern. 

 Text Button  
To access the text editor, click the button shaped as a T in the tool bar. The text 

options will appear in the Control Center, and the mouse cursor will change into 

a cross with an A.  
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Working with Text 
To introduce a new text, double-click the spot in the working area where you 

wish to place it. The cursor will appear in this position as a thick vertical line 

with the same height as the chosen letter size.  Type the text in the normal way 

with the keyboard. If you wish to add new lines, press the Enter key. You can 

also delete characters and move throughout the whole text with the keyboard's 

cursor keys. You can also place the text cursor anywhere you wish by clicking 

the mouse cursor on the desired area.  

 

Selecting the Attributes of the Text  

The attributes of the text to be entered, or text already entered, can be found in 

the Control Center.  

Font type 
In this section, you 

can choose the type 

of font to be used. 

Click the arrow 

situated at the right to 

display the list. All the 

fonts installed in the 

system at that time 

will appear within the 

list.  

A scroll bar appears 

on the right. This 

allows you to scroll through the list to find the 

desired type. Once you have found it, click it once. 

At the top of this list, separated by a double line, 

you will find the fonts previously used in the 

design. This is a 

shortcut for choosing 

fonts already used in 

the design.  

 

You can also choose the body or angle of this font, as long 

as it is available in the font file itself. Choose these 

attributes from the list immediately below. According to 

the font type, you can find Boldface, Italics, etc… 
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Font size 
Here, you can specify the size of text to be introduced or text 

already selected. You can also specify whether you want this 

text to be in Versalite, Subscript or Superscript type.    

Enter the required size in the corresponding section. The size entered is 

calculated according to the height of the upper case characters of the font type. 

For example, if we enter the text "Hello", the height of the "H" will be that of the 

size entered.  

You can alter the size of the text being entered at any time 

in order to obtain texts of different sizes; for example, in 

different lines. The Uppercase converter, Versalite, Subscript and Superscript 

attributes alter the size and position of the characters entered.  

In the case of Versalite, the characters in lower case will be substituted by 

Upper case, but with lower case size. So, if we enter the text "Dollar" normally, 

it will appear in this way:  

 

Subscript reduces the size of the character and situates it below 

the base line of the text. So, if we enter CO2 by selecting the 

subscript button after entering the C, the text will appear as 

follows:  

Superscript reduces the size of the character and situates it above 

the lower case characters. So, if we enter 2562 by selecting the 

superscript button after the third character, the text will appear as follows:  

Alignment and Line Spacing  

In these sections, we can control the way in which several 

lines of text will appear; for example, whether or not they will 

appear centered, and the spacing between them. The 

alignment section has three buttons which allow the entered text to be aligned 

to the left, right or in the center.  

You can choose the type of alignment either before entering new text or once it 

has been entered. If you select it before, the position where you have clicked 

will be the reference for entering the new text. So, if you choose centered 

alignment, the point of insertion will be the center of the text to be entered.  
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The spacing section allows you to establish the spacing between various lines 

of text. There are two ways of setting the spacing: graphically or using values. 

Values to specify the spacing can be entered in three different ways:  

Percentage of spacing with regard to the height of the text. The normal 

spacing is 100%. So, putting in 200% represents doubling the spacing 

between lines.  

 

Distance of spacing between base lines. In this case, the distance is 

taken between the bases of each line of text. The base is the horizontal 

position where all the characters are placed, both upper and lower case. Take 

into account that a character may descend below from the base line. 

 

Distance of spacing between upper case letters. In this case, the 

distance is the real spacing between the base of the upper line and the 

top of the characters in upper case. It is in fact the visible spacing between 

lines. 

To graphically adjust the spacing, click this button and click the line of 

text that you wish to alter. This line of text will appear surrounded by a 

blue rectangle. Place the cursor on the border of the frame on the upper or 

lower side, and the cursor will change into a double arrow. Click and drag up or 

down to move the line of text. This movement cannot be made in the first line 

of text.  

At the same time, press the Control key to separate the lines. Otherwise, you 

will be stretching the text.  

 

 

Distorting Letters  

 

If we extend the Text branch in the Control Center, the 

option to distort the letters appears. Using this option, 

we can widen or narrow the size of the characters, and 

we can skew them towards the two sides.  
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To alter the width of the characters, enter the variation 

percentage into this box, and press Enter. The normal 

width is 100%. Enlarging to 200% doubles the width of 

the characters.  

To alter the angle of the characters, enter the skew 

value in degrees into this box, and press Enter.  

If you want to apply a standard skew, that is to say, the normal angle 

fonts have when they are skewed (italics) - which is normally 15º, click 

the skew button directly.  

 

 

Spacing Between Letters and Words  

In the same section as letter distortion, you will find the options for altering the 

spacing between characters and words. Altering the space between letters 

means increasing or reducing that space.  

 

The normal default value is 0%. If you want to 

separate the characters more, increase this value.  

 

Altering the space between words means separating 

or joining more closely each word in the text to be 

entered.  

The normal default value is 0%. So, if you want to double the distance between 

words, enter the value 200%.  
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Graphical Adjustment  

It is possible to graphically adjust the text size, the spacing between characters 

and words and the distance of spacing between text lines.  

Click the line of text that you wish to alter. This line of text will appear 

surrounded by six small triangles. We will call them 'handlers'.  

 

 

The up / down handlers at the middle of the text will allow us  

 to stretch the text vertically;  

 To change the space between lines of text. This movement cannot 

be made in the first line of text.  

 

The up – right and left handlers will allow us to alter proportionally the 

size of the selected text. 

 The handlers below right and left are used as follows: 

 To stretch the text horizontally. 

 Depressing Control key: to change the distance between characters 

in the selected text line.  

 Depressing Shift key: to change the distance between words in the 

selected text line. This can also be done with the control tabs which 

appear vertically over the text. 

Saving the Text Set-Up  

As in other branches of the Control Center, a button appears with a 

disc that allows you to save by default all the set-ups that are selected 

at the time. We can, for example, ensure that every time we access the 

text options, the centered text and the line spacing in inches are selected.  
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Entering Symbols  

The text editor has a special function for entering symbols or special characters 

quickly. The editor only shows the fonts for symbols, such as "Wingdings" for 

example.  

In order to introduce a symbol, select the text tool, then click the 

working area twice, or select a text and the text tool. The text section 

and the Symbols branch will appear in the Control Center. Select this 

branch, and all the installed fonts for symbols will appear. 

Pick the desired font and all the available symbols for this font will appear in the 

Control Center window.  

 

To introduce the desired symbol, simply click it twice, and it will be entered at 

the cursor position of the text. 

 

 

Vertical Text  

With the program you can automatically create a vertical text without having to 

place the characters manually. 

1. Write the text normally (see Text Entry section) or select one you 

have entered before.  

2. Click the vertical text button:  
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The text characters will be placed one above the other. They will be 

centered in relation to their width.  

If you wish, you can also enter the text in vertical directly. In this case, 

before starting to enter the text, click the vertical text button. If you 

need to do more than one column of text, the cursor will move to the 

next column when you press the Enter key.  

 

 

In this case, you can specify the space between 

columns in percentages. The normal distance is 100%. 

A greater value will increase the distance.  

You can also control the alignment among the 

characters. They will be centered by default, but they 

can all be aligned to the left or right, by clicking the 

following buttons:  

Adapting Text to Curve  

The program allows you to adapt a text to any curve. Introduce the 

text normally. It will be selected. 

From the Text menu, choose the Adapt to curve option or click the adapt to 

curve button 

The cursor will change shape. Click the curve where the text will be adapted. 
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Position with Regard to the Curve  

This allows us to specify whether the text will be positioned above 

the curve, in the middle of the curve or below it.  

 

 

In these two examples we can see a text above the curve, and one below it.  

 

Alignment  

This allows us to determine the position where the text will be with 

respect to the trajectory, whether to the left, in the center or to the 

right.  

 

Direction of the Characters  

This option allows us to determine how the characters will be 

altered with respect to the curve.  

 Rotate the character according to the angle of the curve at 
the point where each character is located.  

 

 

 Keep the characters straight, moving only the position of the 
base of each character.  
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 Rotate and skew the characters according to the trajectory's 
curvature, thus creating a three-dimensional effect.  

 

 

 

Orientation  

If the text is to be adapted to a closed object, you can specify on 

which side of the object it will be placed. The available options 

are: above, to the left, to the right and below.  

 

 

Reversing the Direction  

The option “Put to the other side” lets you reverse the direction in which the 

characters are written. Thus, for example, it might be interesting to have a text 

which is located in the lower part of a circle readable from left to right. In this 

case, if we did not choose this option, the text would remain clockwise and the 

lower part would read from right to left.  
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Working with Shapes 

 Rectangles Button 

To create a square or rectangle, proceed as follows: 

 Select the icon showing a rectangle; the cursor changes it 

into a cross and a small rectangle.  

 Click the drawing area at a point where you wish the square 

or rectangle to appear.  

 Without releasing the mouse button, drag the cursor towards 

the opposite side of the square or rectangle, and you will see 

how the desired figure takes shape.  

 If the shape and size are correct, release the mouse button 

and the new object is created. 

 

If you press and hold down the Control key while moving the mouse pointer, 

you will be creating a square. Otherwise, you will create a rectangle. 

By pressing and Holding down the Shift key, and at the same time clicking the 

initial point of the square / rectangle in the working area, the program will take 

the marked point as the central point of the figure.  

 

 

It is possible to create rounded corners automatically. There are four sections 

to control the ratio of each corner independently or at the same time selecting 

the option Symmetric.  

Enter the radius of the curvature of the corner, or put 0 if you want the straight. 

You can also control the radius of the corners graphically. If you create a 
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rectangle with rounded corners, a black dot appears in each corner. Place the 

cursor on this black dot, click and drag it, and the corner's radius will change.  

If the cursor is within the rectangle, the corner will be made outwards. If the 

cursor is moved outside the rectangle, the corner created will be inwards. If we 

press the Control key an outwards corner will be created. Otherwise, the corner 

will be created inwards. 

 Ellipses Button 

The circle or oval will be created within a rectangle described by two marked 

points which correspond to the edges of this circle or oval.  

In this case, on pressing the Control key, perfect circles are created. Otherwise, 

are created.  

As with the previous case, you can also adjust the parameters in the Control 

Center.  

 

The Cut option is used to create portions of circles. By activating this option the 

initial and final angle that will that will be cut the circle can be specified.  The 

option Closed indicates that the curve will be completely closed by two straight 

lines towards the center. If this option is not activated there will be only one 

circle arch. However, take into account that this arch cannot be cut if it is not 

closed. 

The following examples show the results.  
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Circle cut between 180° and 90° closed.  Circle cut between 45° and 90° not 

closed.  

 Polygons Button   

This is used to create polygon-shaped objects. The button for accessing this 

function is found in the tool bar and shows a five-sided polygon. This tool works 

in the same way as the star creation tool, except that you cannot set the interior 

diameter of the points, since it only has exterior points. So, while the polygon is 

being created, the Shift key does not carry out any action.  

 

In the Control center it is also possible to numerically determine the parameters 

of the polygon, like the position, external size, number of sides and ratio of the 

corners. The ratio of the corners can also be graphically established if we click 

on one of the points of the corners and if we drag it inwards or outwards.  

 

 Stars Button 

 This is used to create star-shaped objects. The button to access this function 

is found in the tool bar and has a star on it. To create a star in the design, first 

click this button. Click the working area in the position where you wish to place 

its center, and without releasing the mouse button, drag the cursor towards any 

side. As the cursor is moved, the star will be drawn on the screen.  

If you press the Shift key while moving the cursor, you can alter the diameter 

formed by the interior points. If you move the cursor's position away from the 

diameter of the exterior points, these will become interior ones. If you press the 

Control key while creating the star, this can be rotated in any direction by simply 
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moving the cursor to the desired position.  Once you have created the star, all 

its parameters can be altered provided the tool is not changed. These 

parameters are: position, diameters, number of points, thickness of the outline 

(optional) and the rotation angle. All of these values appear in the Control 

Center.  

To modify any parameter, enter the desired value and click on the “Apply” 

button, the changes will be made automatically.  The values shown belong to 

the following in ascending order: Horizontal position, vertical position, external 

diameter of the ends, interior diameter and number of ends.   

 

You can also set by default the parameters with which the new stars will be 

created. In this case, the number of points, the thickness of the outline and the 

rotation of the star can all be set. Alter the values according to your needs, and 

click the Apply button or press the Enter key.  

It is also possible to graphically modify the size of the ends, clicking on the 

points that appear on the corners of each internal or external end and dragging 

these points outwards or inwards, as it is shown in the following figure:  
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 Digitize / Bitmap Tracing Button   

 Point Digitization Button   

 Free Hand Drawing Button   

 

This is used to create figures of any shape. The button for accessing this 

function is found in the tool bar, and shows a pencil with a continuous line. To 

create a figure, click the working area, and without releasing the mouse button, 

move the cursor, following the outline you want to create. On releasing the 

mouse button, the trace created will change into a succession of curves and 

lines, thus forming the new figure.  

If you make the final point coincide with the initial point of creation, this figure 

will be closed. Remember that once the figure is created, you can alter its 

trajectories by editing the nodes.  
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 Outlines Button   

This function allows you to give your designs 

profiles. To create profiles, choose the objects 

to be profiled, and select the Transform-Profiles 

menu. A dialog box will appear with the 

following options. 

The program permits to create external and 

internal profiles for the selected object. Outer 

Profile will be created outwards with respect to 

the selected figure.  

 

“Inner Profile” will be created inwards with 

respect to the figure.  Please note that 

depending on the type of the design and the 

thickness of the internal profile, in some parts it 

may be impossible to create the profile and it will disappear.  

The option “Original” generates a copy of the 

selected object when it creates the new profile. 

It duplicates the original object.  With option 

“Only External”, if we create an external profile 

and the original object has some holes (internal 

forms) no profiles will be generated on these 

forms.  

This image shows an external profile, the 

second one with the option “Only External”.  

 

 

The option “Transform with the source object” relates the generated profile to 

the original object so that if the original object is modified, the profile will be 

modified according to the parameters used to create it. For example, if we 

create a profile for a text and then we modify. This text, the profile will be 

recalculated and it will not be necessary to create a new profile.   

The “Corners” button permits to control the forming of angled corners. This 

refers to the minimum angle when you create outlines. Sometimes, for very 
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closed angles for example, the outline’s extension may create an unexpected 

effect. If you are not sure of how the minimum angle works, we recommend not 

changing the default options.  

 

 No-Cutting - This will create the outlines without taking into account 

the angle. 

 Straight - will create the outlines, cutting with a straight line the line’s 

outlines whose angle is less than the specified angle in “Limit Angle”.  

 

The distance of both the internal and external 

profiles can also be graphically established 

clicking and dragging the controllers in the 

center of the object.    

 

A blue rectangle will appear showing the limits 

where the new profile will be generated 

 

 

 

Click on the “Apply” button to generate the profile.  
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Distortions 

This utility allows you to carry out an unlimited number of distortions in a 

completely graphic manner, as well as save these distortions and apply the 

ones saved previously. To access this function, click the 

distortions/perspectives button.  

Select Effects in the Control Center, click on the New button and select 

Deformation.  

 

 

The selected object appears surrounded by a blue rectangle with four points at 

its extremes. These four points will be the principal controllers. Apart from 

these, you can add as many points as you like, and in the position that you 

want, by simply double-clicking on the desired area of the rectangle.  

The segments joining the points can be converted into curve if required. To do 

this, click the segment with the right-hand button of the mouse and select to 

curve. Two control points which control the Bezier curve points will then appear.  

Every point of the rectangle and every control point can be moved freely, giving 

shape to the distortion as needed. When you make any change, a schematic 

representation of the selected object appears showing the effect of the 

distortion. Depending on the complexity of the object to be distorted, previewing 

the distortion may take a considerable amount of time. If you would rather 

disable the preview, deselect this option from the Control Center.  
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Once the desired distortion has been carried out, you can save the 

effect created, by clicking the button to save distortions. A preview 

appears in the Control Center viewfinder.  

To apply a previously created distortion, click this distortion twice, 

and it will be applied automatically to the selected object.  

 

 

 

If you are creating a distortion and you would like to start again, press the reset 

button. The object will then convert to its original shape, and the rectangle of 

distortions will go back to having only the four extreme control points.  

 

In the Control Center preview, where all the distortions created 

appear, a contextual menu is also available which allows the following 

actions:  

 Delete a saved distortion.  

 See the distortions preview in three different sizes.  

 See the preview in linear mode or with fill-ins.  

Perspectives 

Perspectives are a variation of distortions. To carry them out, activate the option 

in Effects in the Control Center. The program lets you create both horizontal 

and vertical perspectives, individually or at the same time.  

To make the perspective, move the control points to the desired position. You 

will immediately see a preview of the perspective which will be generated.  

 


